
V11 Release Notes -  2017 

 Constant Contact Integration 

 As part of the major Campaign Manager enhancements, users can now connect 

their Constant Contact account in order to transfer contacts from DLCPM 

customer base into Constant Contact.  

 

 Calls Calendar:  

 Under the View menu from the top of the toolbar is a new option to open the 

Calls Calendar. The Calls Calendar allows for users to view all assigned calls to 

either multiple users or groups. Users may view calls for a single day, work 

week, full week and month. New calls can be created from this form as well as 

patient appointments. Users have the ability to drag and drop to change call 

assignments and due dates.  

 

 Tax Integration 

 Tax Integration provides labs with the ability to charge the correct sales tax by 

assigning a tax code for each customer based on the city and state on the 

customer record.  The tax integration communicates with the tax company in 

order to retrieve the correct tax code when a case is entered and invoiced in 

DLCPM.  

 Data Audit Trail 

  Under the Administrator menu at the top of the toolbar, there is a new form which 

contains the following sections of data audit trail: 

o Constant Contact 
o Lab ConneX 
o Calls  
o Case Products 
o Cases 



o Catalog Products 
o Customers 
o Customer Special Prices 
o Lab Customer Settings 
o Products 
o System 

 
 The data audit trail contains audit logs of changes made by all users in the 

system in each section listed.  

 Data Audit Trail has replaced the ‘View System Log’ and ‘View LabConneX Log’ 

options which were located in the Administrator menu. The Data Audit Trail log 

will now display logs for tracking changes and activity in various areas of 

DLCPM. 

 
 Load Scheduling Assignment (LSA): 

 LSA is a process that will assign the tasks to qualified Technicians or Teams. 

DLCPM uses a “Genetic Algorithm” and Depth Level to create most optimal 

assignments which incorporates predefined technician availability, proficiency, 

lab hours, case due date, and other criteria. The Depth Level is the number of 

iterations that the system will perform which ranges from 1 to 10 with an optimal 

setting of 3. Please note, the larger the depth level, the longer process time.  

 There are a number of requirements for LSA to be most effective. Listed below 

are the most critical steps that must be set up in DLCPM before utilizing the LSA 

feature: 

o Business Hours 
o Technician Hours 
o Tasks that can be performed by each Technician 
o Proficiency required for the Task 
o Customer Technician Preference, if applicable 
o Equipment set up, if the certain Equipment should be included as part of 

LSA. (For example: Milling Machine) 



 

 Advanced Query Builder: 

 DLCPM has always provided a large number of built-in filter queries for 

Customers and Cases. As the laboratory industry evolves, laboratories may need 

more advanced queries for data mining and export purposes. Laboratories also 

may need to have the ability to create queries for all data available to analyze in 

the system. DLCPM now offers the option Advanced Query Builder with an 

‘English-like’ interface to allow users to create custom queries. This feature has 

also expanded to provide a large selection of data sources such as Calls, 

Catalogs, Campaigns, Sales, and a number of other available data. 

 

 Advanced Export: 

 With the introduction of Advanced Queries, it has become necessary to provide a 

more robust Export feature. Unlike previous versions of DLCPM where users’ 

export was restricted to a couple of data sources, this new option now provides 

the ability to create a template for many data sources and the desired columns to 

export. The data sources expand to many more tables to pull different types of 

data from.  

 

 Inventory Management System: 

 DLCPM Inventory is designed to track consumables (materials such as powder) 

and items or products sold which are not part of the manufacturing process (for 

example, an implant screw). The inventory system utilizes the two existing parts 

of DLCPM namely Materials and Products to build the inventory items. The 

inventory items are depleted in two ways: 1. If the item is a product, the 

inventory is reduced each night via a specific automation job for all product 



materials on Invoiced Cases 2. A technician can check out an item defined as a 

material. 

 The DLCPM Inventory system also includes definitions for Vendors and 

Purchase Orders (PO). Labs may create a purchase order with desired Vendors 

and receive the PO to update their inventory count. The PO requests may be sent 

automatically to the Vendor as well. 

 Here is a brief list of Inventory Features and Functions: 

o Create list of Vendors 
o Create inventory item list from existing Materials or Products 
o Assign preferred Vendor for each Inventory item 
o Generate and Receive Purchase Order(s) 
o Email Purchase Order to Vendor manually or automatically each night 
o Inventory Checkout for Technicians 

 

 Chairside Appointments 

 Under the View menu at the top of the toolbar, there is a new option for 
Chairside Appointments.  When creating New Patient Appointments for 
customers, the records are saved as Call records which will default to the 
‘Chairside’ call type.   

 

 Shipping: 

  The Carrier Shipping Integration has been completely rewritten and enhanced.  The 

Shipping Carrier maintenance has been relocated from the Shipping Carrier Account 

in the Global Settings to the Laboratories maintenance under Laboratory Lists. 

   A new drop down menu has been added under the Shipping Carriers tab of the 

Laboratory Settings to set the default Service Type. This will allow for users to set a 

default service type for both UPS and FedEx shipments. 

 

 System Admin Program – Application Policies: 



  New Accounting Application Policy added which allows for users to Delete 

Payments 

  New Case Application Policy has been added which allows users to Delete Case 

Documents & Attachments 

  New Case Application Policy has been added which allows users to Complete 

Production Tasks 

  New Case Application Policy has been added which allows users to Reject 

Production Tasks 

 

 Accounting: 

  All GL account types maintained under the Laboratory Lists maintenance in 

Global Settings are now available for selection from the GL Account dropdown 

selection when posting credit and debit adjustments.  Previously, only GL Accounts 

defined as the type of Sales were available from the dropdown menu.  

 

 Alerts: 

  Users now have the ability to add an alert at the Customer account level, that 

would appear as soon as the customer record is accessed.  The following Alert 

options have been added:  

o Alert appears when accessing Account via Customer Search 
o Alert appears when you get a single result from the Customer Search 
o Alert appears when you ‘Go To Customer’ from Case Finder List 
o Alert appears when you ‘Go To Customer’ from Call Note 

 
  Invoicing alerts will now be activated when a case is invoiced for TryIn, when the 

TryIn Invoicing Case Option ‘Do not invoice the case, just change the status’ set in 

Global Settings. In previous versions, alerts would not populate when this Global 

Setting option is set since the user is not actually invoicing the case. 



  Customer/Case Alerts configured to notify user when the Accounting tab is 

accessed will now also notify users when selecting the Receive Payment option 

from the left sidebar.  

 

 Case Attachments: 

  The Case Images & Attachments tab has been enhanced to allow for users to add 

multiple attachments instead of being limited to 6 case image attachments at a time. 

  When selecting to remake a case, the ‘Transfer Case Attachments’ option is now 

automatically checked by default. 

   

 Calls: 

  In the My Calls grid, a column for Pan Number has been added. 

  Under the right-click menu, an option has been added to complete the selected call. 

  A new checkbox option has been added under the CRM Lists section of the Global 

Settings, for ‘Call description can only be selected from the predefined list’. This 

checkbox option restricts Call Descriptions to dropdown value selection only 

instead of the free text box. 

  Under Call Entry/Edit, a new checkbox option ‘Print Last Call Note on Workorder’ 

has been added to Call Note Options. 

  From the Pending Calls tab on the Customer form, a column to display Call Status 

has been added to the main grid area.  

  On the right-click menu, an option to ‘Print All Calls for this Customer’ has been 

added. This gives users the ability to print all Call Notes from all Calls on a given 

case from the call grids such as customer Call & Notes grid, and the My Calls grid.  

  Regardless of which Call form or window users have open, access to the right-click 

menu options are now available: 

o Complete 



o Modify 
o Delete 
o Flag this Call (Toggle) 
o Reassign 
o Open Related Case 
o View Related Case Images 
o Print this Call 
o Print all Calls for this Customer 
o Set Columns Order 

 
  A new checkbox option has been added for 'When adding Notes to Calls linked to 

Cases, Share with Technician by default’. This checkbox option has been added to 

the Calls section in Global Settings. 

 

 Case Audit Trail: 

  The Case audit trail has been enhanced to include when the Allow Overwrite 

option on the case Notes & Instructions tab is used.  When a user selects to 

overwrite the preferences populated on a case, the following in logged in the Case 

Audit Trail:  

o The preference changes  

o Username of the user that made the changes 

o Date & Time of when the changes were made 

  Due Date changes on cases when the right-click menu option for ‘Change Task Due 

Date and Re-Schedule’ is used is now logged in the case audit trail. 

 

 Case Entry: 

  Under the Case Entry section of Case Options under Global Settings, the Case 

Entry option for ‘Check all Open Cases for duplicates on New Case (Cancelled, 

On Hold, Sent for TryIn)’ has been revised. The revisions to this option provides 

the option to alert users on case entry only, or after entering patient name. The 



different case statuses have been separated allowing users to select an individual 

status or multiple statuses. This option has also been enhanced to now display 

the case count for Cancelled, On Hold, and Sent for Try-In cases found in the 

alert. 

  A new checkbox option has been added to the Case Dates tab of Case Options 

under Global Settings for 'When creating new case keep same Date In on "Save & 

New"’. 

  Under the Case Entry section of Case Options under Global Settings, a new 

checkbox option for ‘Automatically add time stamp to WO Notes’ has been added. 

When this option is activated, any users that adds notes into the Work Order Notes 

section of a case will have a timestamp automatically added. 

  On Case Entry, the Patient Appt. time field now defaults to 12:00 AM instead of the 

current time. 

 

 Case Finder:  

  The Preference subtab in both the Case Finder and the Cases tab on the Customer 

form now consistently displays the following fields: 

o Workorder Notes 
o Invoice Notes 
o Web Comments 
o Remote Preferences Instructions 
o Web RX Preferences 
o Task Preferences 

 

  New columns for both ‘Teeth USA’ and ‘Teeth FDI’ have been added in Case 

Finder. 

  A new section for Reject Reason Notes has been added to the 7. Tasks History 

subtab in Case Finder. 



  Two new queries have been added to the Financial category in the Case Finder 

Cases Query dropdown: 

o Credit Adjustments 
o Debit Adjustments 

 
 

 Cases:  

  On Case Entry/Edit, a column for Production Lab has been added to the Products 

tab grid. 

  The Discount field on the 2. Tab for Remake & Discount is now a combo box and 

the discount code is validated when users hit tab or enter and also this field can be 

scanned by a barcode. 

  The Remake Reason field length on Case entry/edit of remake cases has been 

increased. 

  The Address Line 2 has been added to the Select Customer window which 

populates when entering a new case. 

  Users now have the ability to search by Customer and Practice Doctor Address 

Line 1 and Address Line 2 on the Select Customer window on Case Entry. 

  From the Shipping tab on Case Entry/Edit, users are able to select to ‘Overwrite 

Delivery Name for Carrier Shipment’. 

  Users have the ability to select to overwrite the task preferences for a case by using 

the ‘Allow Overwrite’ checkbox option which is available on the Instructions and 

Task Preferences sub-tabs of the case Notes & Instructions tab. 

  When cases are invoiced, users now have the ability to edit the Invoice Notes from 

the Actions option.   

 Visual indicators have been added on the Tasks page for late tasks: 

o Green - Completed on or before task due date 
o Yellow - Completed late – after task due date 
o Red - Not completed and the due date has passed 



o No legend (colorless) - Due date is in the future 
 

 Complaints:  

  Users now have the ability to Add Customer Complaints without having to relate 

the complaint to an existing case. Users can simply select the ‘Register Complaint’ 

option from the left panel of the Customer form.  The Case Number field will 

display ‘Not Linked to a Case’.  

  In previous versions, Customer Complaints read the product lot number only.  

Customer Complaints has been enhanced and will now read both Material and 

Product lot numbers. 

 

 Global Search:  

  Additional information such as doctor name and account number has been added 

to search results display.  

  Users now have the ability to export search results into Excel spreadsheet file using 

an Advanced Export template. 

 

 Global Settings - Products:  

  A checkbox option for ‘Allow Warranty’ has been added under product 

maintenance in Global Settings which allows for users to set a warranty at the 

product level.  The Warranty checkbox and Expiration Date field have been added 

on the Case Product form. 

  When editing a task from a product’s schedule, a new drop down menu has been 

added to set the task Department. 

 The GL Account field has been added to the Sales Distribution tab of Product 

maintenance in Global Settings. 

 



 Global Settings - Production Tasks:  

  Users now have the ability to add technicians based on their Department. There are 

filters for Employee ID, Employee Name, Department, and Lab that have been 

added to the Add Multiple Technicians to Task form. This option can be accessed 

from the ‘Select Technicians and Pay Rates’ option on the Technicians tab of 

Production Task maintenance in Global Settings.    

  As an enhancement, pagination has been added to the Production Tasks 

maintenance form in Global Settings. 

  In the General section of the Case Entry tab of the Global settings, an option for 

'Always set payrate to zero when completing tasks on Remake cases' has been 

added.  When this option is checked, the Pay Rate field on the Complete Task form 

is disabled on remake cases, and still enabled on non-remake cases.  

 

 Tasks:  

  A Complete Date and time dropdown has been added to the Complete Tasks form. 

  When using the ‘Allow for rescan’ option, users are now able to select multiple 

tasks to rescan by using the Shift + click combination. 

 

 TAPI Application:  

  TAPI Application now displays additional customer information, including city. 

 

 Tool Loan:  

  A checkbox option for ‘Do Not Allow Tool Loan’ has been added to the Practice 

Info tab of the Customer form.  When this option is checked and a user attempts to 

add tool loans, an error message will display with the following ‘You cannot add 

Tool Loans for this Customer’ 

 



 Customer Settings:  

  A new option for ‘Copy Purchase Order to Another Customer’ has been added to 

Purchase Orders section of the Customer Settings.  

  Two new checkbox options have been added on Add/Edit Special Prices in 

Customer Settings: 

o Do not allow to overwrite price – When check, this option prevents users from 
overwriting the set Special Product Price. 

o Do not allow discount – When checked, this option prevents users from adding a 
discount on the Special Product. 

 

 Customers:  

  A column to display case Hold Status has been added to the 4. Cases tab of the 

Customer Form. 

  The length of the Credit Hold Notes field found on the customer Accounting tab 

has been increased. 

  Customer Fulfillment information is now included when users select to use the 

menu option to ‘Transfer related records from another Customer’. 

  A new Customer Office Hours sub-tab has been added to the Customer Main tab.  

Morning and Afternoon open and close hours can be set for each day of the week. 

  Customer Billing Account Information, including Billing Account ID, company, 

name, phone number, and email address are now displayed on the customer 

Accounting BA Balances & Notes sub-tab. 

 

 Customer Search Enhancement:  

  A new shortcut key of ‘Alt + b’ which allows users to search by Case Number has 

been added to the customer form.  

  The Customers View option ‘When Finding Customer, enter key searches by Case 

Number’ has been added in users’ Personal Settings. 



 

 Customer – Education Courses:  

  A new ‘Start Date’ field has been added to the Add Education Course form to 

indicate the date the course is scheduled for. 

  The Course Description and Course Location fields have been increased to allow 

for a 90-count character limit. 

  A new maintenance list section has been added to define Subject Codes. The 

maintenance for Education Courses has been added under the CRM Lists section of 

the Global Settings.  

 

 Practice Doctor: 

  When adding a Practice Doctor, a field has been added for ‘Exp. Date’ which is 

intended for the License # expiration date. 

 

 Employees: 

  Three new checkbox options have been added to the Add Task form under the 

Update all Employee’s Tasks heading: 

o Apply selected Rate to all Tasks 
o Apply Customer Duration to all Tasks 
o Apply Proficiency configuration to all Tasks 

 
  When adding a task to an employee, there is a checkbox option called "Custom 

Duration" to change the units per day. There is no way to know if a given task 

should be customized without remembering what it was set to in Production Tasks. 

The values from production tasks are now displayed so it is easier to decide if 

customization is needed. 

  A column to search on the employee Tasks tab now returns results containing the 

text entered. 



  When adding or editing Employee Tasks, a Search Task window now allows for 

column searching. 

 

 Incoming Shipments: 

  Patient First and Last Name are now automatically capitalized when adding 

incoming shipments. 

  A checkbox option has been added to the Incoming Shipments to ‘Include Inactive 

Customers and Activate when Cases are Added’. 

 

 Shipping Manager: 

  A column for Last Task Scanned has been added to the Potential Cases to Bundle 

section of the Shipping Manager. 

 

 System Template: 

  The following system merged fields have been added to the system template Daily 

Alerts with Hold: 

o Ship Date 
o Due Date 
o Patient Appointment Date 
 

 Statements: 

  Users now have the ability to select multiple statements when viewing and 

emailing statements from the customer Accounting tab. 

 

 Products: 

  When adding single or multiple products to a case, users can now use Alt + N to 

jump to the case Product Invoice Notes section. 

 



 Pickups: 

  We have made the following changes to allow multiple dispatchers to be able to 

handle their own route: 

o In the Routes section under Shipping in Global Settings CRM Lists, a dropdown 

list has been added for users to select the Dispatcher for that route.  

o In the Pickup Manager, a new dropdown menu has been added to filter the list 

by Dispatcher. 

o When adding pickups in previous versions, there is a checkbox option for 

“Notify Shipping Manager” by Email/ePop. This has been changed to now read 

“Notify Dispatcher” and will now notify the Dispatcher for selected Route. 

  A new Email Address text box and Info Method dropdown menu has been added 

in the Route Driver maintenance under Shipping in CRM Lists Global Settings.   

  A new option for 'Inform Driver' has been added in the Pickup Manager. When 

this option is selected, an email or text will be sent to selected driver based on 

Route Drivers settings. 

  Users now have the ability to add a Tracking Number on the Add Pickup form.  

The Tracking # is enabled if the carrier is not a known carrier (such as FedEx, UPS) 

or Local Delivery. 

  As an enhancement, pagination has been added to the Pickups & Local Deliveries 

sub-tab on the Customer form. 

 

 Payments: 

  A label has been added to the post payment form in red/bold text and is displayed 

if the customer is on Credit Hold. 

  Users now have the ability to print a selected invoice from the Post Payment 

screen. 



  The Payment Methods maintenance is now available in Customers under CRM 

Lists in Global Settings. In previous versions a standard list was only available for 

selection. 

 

 Customer Log: 

  Revision entry logs are now written to the Customer Log when Accounting 

Finance Charge options 'Apply Finance Charge' or 'Use Global Setting Rate' found 

on the customer Accounting tab under the Billing Options sub tab are 

enabled/disabled. 

 

 Global Settings: 

  A new 'Report Forms' maintenance section has been added to the Miscellaneous 

section of the Global Settings: 

o When adding a New Report Form, a dropdown menu for Form Type is 

available. The content of this dropdown menu is to the list of all forms found on 

Forms tabs of Add/Edit Lab. 

o There is an edit box available for users to enter the Form name. 

o A lookup list has been added for all the Form names to display their respective 

file name. 

 

 E-Mail: 

  Users are now able to manually enter email addresses in the ‘CC’ field when 

sending emails. 

 

 Fulfillments: 



  Customer Fulfillments can now be prioritized when adding fulfilments with the 

new ‘Rush Request’ checkbox.  The ‘Rush’ column has been added in the 

Fulfillment Manager grid for view. 

 

 Outsourced Cases: 

  The QC Rating (Outsourced Cases) option has been relocated from the View menu 

to the Tools menu. 

 

 Volume Discount: 

  A new option to ‘Exclude Customers with any Past Due Balance’ has been added 

under the Volume Discount section of the Global Settings. When checked, this 

option will exclude any customers with past due balances that are setup to receive a 

volume discount. 

 

 Personal Settings - Printers: 

 Two new printers have been added in Personal Settings to accommodate newly 

added shipping integration: 

o TNT Label Printer 

o Chronopost Label Printer 

 

 Merchant Accounts: 

 Credit Card integration has been implemented for two additional merchant 

processors and can be configured under Laboratories in Global Settings: 

o Authorize.net – This integration has existed in previous versions but now 

supports the ability to void and refund transactions from DLCPM 

o Basys 

 



 Laboratory Settings for Customer Portal: 

 The Service Center Name for scheduling Pickup can be specified under the 

Customer Portal options from the Settings tab when editing a lab in Global 

Settings. When scheduling pickups, the service center name will display in the drop 

down menu. If this field is left blank, the full Lab Name that is set on the General tab 

will be used.  

 

 Automated Services – Job Management: 

 A new option has been added to mark a job as Custom. When selecting to mark a 

job as a custom job, this will prevent future updates to replace the job. Please 

note, System jobs may not be set as Custom.   

 Two new columns have been added to the Automation Jobs grid: 

o Custom Job – this column will display if the corresponding job has been 

marked as a custom job 

o System Job – this column will display if the corresponding job is a system 

job 

 

 Common Notes: 

 The Common Notes maintenance in Global Settings has been enhanced to 

allow for users to create long formatted text as a common note. 

 

 General Enhancements: 

  A new option for 'Show Sidebar Main Menu' has been added to the View menu. 

Users are able to customize the view and hide the left sidebar. 

  The F11 hot key now provides quick access to open the Report Center. 

 

 Corrections: 



  Various spelling and text display corrections have been made throughout all 

applications. 

  The label on the case Follow Up Call tab under Create Alert has been updated to 

match the labeling on the customer form. 

  In previous versions, incremental searches on the case Follow Up Call tab did not 

behave consistently.  This has been corrected. 

  Hitting the space bar now activates the Call Type and Description fields on the case 

Follow Up Call tab. 

  Previously, users were sometimes unable to click through the multiple pages of 

customer query results on the customer form.  This pagination has been corrected. 

  Column sorting has been corrected in several grids throughout DLCPM. 

  When editing a pickup, the Service Type under Carrier Pickup now displays the 

code and description.   

  The Date Column on the Calls & Notes tab of the customer form has been renamed 

‘Due Date’ for clarity. 

  In previous versions, double quotation marks in the ‘Description’ field under 

Education Courses maintenance in Global Settings caused values to be saved in the 

incorrect fields.  This has been corrected. 

  The ‘Add’ button has been disabled on the Materials tab of invoiced cases. 

  When the checkbox option for ‘Enable Credit Card Payment’ is enabled on the 

Merchant Accounts tab under Laboratory maintenance in global settings, the 

system will check and validate for credentials upon Save. 

  In previous versions when typing text for search criteria, the Enter key, activated 

the query drop down menu instead of invoking the search.  This has been 

corrected. 



  Certain characteristics of Productions Tasks such as Vital to Invoice and TryIn 

Break Point were not inherited by default when tasks were manually added to a 

case schedule.  This has been corrected. 

  In previous versions the right-click option to Complete a call was not respecting 

software locks which allowed a user to complete a call while another user had the 

call open for editing.  This has been corrected. 

 


